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At the end of this chapter, students will be able to:
+ Make charts in Excel.

+ Recognise the components of a chart.

+ Format charts and sort data in a worksheet.

Observe the following chart carefully. What does it represent?

Sales of Product A and Product B
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Sales (USD)
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.‘Te,acﬁer’s Guide students with the help of a chart to easily understand the data and compare values.
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Hey Friends! Lets learn how to
make charts using the data from
the worksheet.

In order to efficiently handle a big amount of information in spreadsheets, Excel offers
several extremely helpful functions including charts, sorting, and filtering data.

Humans are visual learners, therefore when given reference visual points, their under-
standing is enhanced. One efficient way to represent data in a pictorial form is through
charts. We can easily understand and compare data values with the help of charts.

Charts depend on the data of a worksheet. When the information in the spreadsheet changes,
the chart is immediately updated.

@ MAKING A CHART
As stated above, in order to insert a chart in a worksheet, we need to add some data to it.

Follow the given steps to make a chart in Excel:

Steps: " Let Me Answer

Have you ever made a chart in

1. Select the data from which you want to make a chart. Jour Mathematics class?

2. Click on the Insert tab.

A = C D
11_ Make Colours Odometer Price
2 JHGr‘lda White 17667 J300000
3 |TVS jupiter Black 290312 820000
4 Yamaha Red 456665 40000
2 |Bajaj Green 97111 J00000
6 |Royal enfield Blue 340015 3500000
7 _f-".pachE Black 877774 5000000
8 |HeroSplendor  white J8BE9 90000000
g
10
1

Figure 1.1: Creating chart
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In the Charts group, click on see all charts button to open the Insert Chart window.

Click on the All Charts tab and from the list of charts shown in the left pane select
column.

Click on the ‘oK button to insert the chart in the worksheet.
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Figure 1.2: Insert Chart Figure 1.3: All Charts

@ ELEMENTS OF A CHART

Various elements of a chart are:

1. Chart Area: All the area and other objects of a chart are included in the chart area.
2. Category Axis: The horizontal area of a chart is called the X-axis or category axis.
3. Value Axis: It is the vertical axis which is used to plot the values and is called the Y-axis.
4. Data Series: Data series consists of the bars, slices, lines or additional elements that
show the data values.
5. Category Name: The labels visible on the X and Y axes are the category names.
6. Plot Area: A window within the chart area is the Plot Area. “
e
7. Legend: Colours, patterns, or symbols assigned to the data Let M Answe
; . efine x-axis and y-axis.
series are depicted by legends.
@ FORMATTING A CHART

The look of the chart is enhanced by formatting. Chart elements, chart styles, and Chart
Filters can also be formatted. We can also change the numbers on the value axis, and hide
or show gridlines.
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Changing the Title of a Chart

Follow the given steps to edit the Chart title.

Steps:

1. Click on the chart title.

2. Right-click on the Chart Title placeholder, the pop-up menu will appear.
3.  From the pop-up menu, select the Edit text option.

4. Add the new Chart Title and press the ESC key.

Editing Chart Elements

Titles, labels, gridlines and data labels can be edited.

?

Follow the given steps to edit the elements. N
<2 % Do You Know?

Steps:

Select the data in the worksheet and press
1. Click on the Chart. the F11 key to create a chart instantly. |

2. The following pane will be displayed.

I Click to edit titles, labels,
gridlines, and data labels.

*-i Click to edit chart styles
- ]
il and color schemes.

i' <«——] Filter the values.

Figure 1.4: Chart Elements

é EDITING CATEGORIES IN A CHART
Follow the given steps to edit categories of the chart.

Steps:
1. Click on the chart.
Click on the filter button.

Select the Categories option and unselect 1 from the Panel.

Ll

Click the Apply button and see the changes.
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Figure 1.5: Chart Filters Figure 1.6: Editing Chart Categories

é FORMATTING LEGENDS
Follow the given steps to edit the legends in the chart.

Steps:
1. Right-click on the legend.

2. From the pop-up menu, select the format legend option to open the Format Legend
Panel.

3. Click on the Fill and Line option.
4.  Select the solid fill option.

5. From the colour drop-down list, select the colour of your choice.

Format Legend v % Format Legend -
Legerd Optisns = Tt ptigna
Legend Options ¥  Text Options {:. il
& Q III . il &
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~ Legend Options ;::::“
Legend Position Prctisse o4 Bertors T
Pymein Tl
IU'F" ® fypomatic
® Bottom - e
L Left
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" Top Right 25
Show the legend without Gtuckar lise:
overlapping the chart ® dygomatic
ol - -
Tiwraparerssy |
Figure 1.7: Legend Option Figure 1.8: Format Legend
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@ SORTING DATA

Sorting is a feature in MS Excel that helps you organise data. You can sort a text column in
alphabetical order (A-Z or Z-A). We can sort a numerical column from the largest to the
smallest or the smallest to the largest. We can also sort a date and time column from the
oldest to the newest or the newest to the oldest.

Follow the given steps to sort the given data.

Steps:

1.
2.

Select the range of cells containing the data to be sorted.

On the Data tab, in the Sort and Filter group, click on the sort option to open the Sort
dialogue box.

From the Sort by drop-down list, choose the column which you want to sort.

Select the values
option from the = - - A : o
Sort On drop- : '
down list.

From the Order
drop-down list,
choose the order of
sorting- largest to
smallest option.
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In the Sort dialogue

box, click on the y -

Add Level button Figure 1.9: Sorting Data

to add a new level

below the firstlevel.  son 7T X

SpCCifY the 4] Add Level || < Delete Level || 2 Copy Level Options... My data has headers
column name as Column Sort On Order

mentioned in the Sortby | price w| |cellvalues | [dargest to Smaliest =
sheet by dropdown

list and order of

sorting as A to Z

in the Order drop-
down list in the e
new level.

Figure 1.10: Sort
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Figure 1.11: Sorting Data with Multiple Columns

Filtering Data
Filter temporarily hides some of the data in a table, so you can focus on the data you want
to see.
i
Sl Ll . W = LZEE LS
A Figure 1.12: Filter Data
Follow the given steps to filter data. e
Steps: REMEMBER IT! &
1. Select the data you need to filter. Ensure that the item of each data type in a
. . ) column is identical before filtering the data.
2. On the Data tab, click on the filter option in
the Sort & Filter group.
3. 'The filter arrows appear next to each column’s heading.
4. Click on the arrow next to the column to specify a condition.
5. A drop-down list appears which provides many options for filtering data.
6. Select the checkboxes of the values based on which you would like to filter the data and

clear all other checkboxes.
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7.  Click Ok.
8. Observe the list which is filtered according to the chosen criteria.
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Figure 1.13: Filtered Data

2= Kids’ 1Q

Sangam has created a chart that shows the grades he received in several exams. He
immediately realised that he needed to modify the colours and symbols used to represent
the data series after creating the chart. Which part of the chart should he use to make the

same changes?

’ Let’s Recall

The chart is immediately updated when the information in the spreadsheet changes.
o The labels visible on the X and Y axes are the category names.
o The horizontal area of a chart is called the X-axis or category axis.

e Data series consists of the bars, slices, lines or additional elements that show the
data values.

o Thelook of the chart is enhanced by formatting.
o Sorting is a feature in MS Excel that helps you organise data in a particular order.

J

o  Filter temporarily hides some of the data in a table, so you can focus on the data
you want to see.
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A. Fill in the blanks.

1. Charts depend on the dataofa ..................

2. The area and other objects of a chart are included in the .............
3. Category axis is also called as .....................

4. A window within the chart areais the ... area.

5. just temporarily hides the data.

B. Write ‘T’ for True statements and ‘F’ for False statements.
1. The X-axis is a vertical axis.
2. Thelook of the chart is enhanced by formatting.
3. Titles, labels and gridlines cannot be edited.
4. Filter helps you organise data in a particular order.
5.

Formatting improves the appearance of a chart.

C. Answer the following questions.

1. Explain any three elements of a chart.

----------------------------------------------------------------------------------------------------------------------------------------------

..............................................................................................................................................

3.  Write down the steps to sort data.

..............................................................................................................................................



4. State the difference between sorting and filtering.

Ramesh is the head of the accounts department in the organisation. He has made
an Excel sheet which displays the name, designation, salary and bonus of each
employee. However, he is asked to show the sheet to one of his colleagues but is not
allowed to disclose the bonus given to each employee. Suggest to Ramesh how he

can hide the specific data.

Team Work

Work in pairs. Imagine your school has organised an inter-class race. In sheet 1,
add the names and timings of the players in Team A. Further, add the names and

timings of the players in Team B in sheet 2.
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At the end of this chapter, students will be able to:
+ Recognise Python keywords.

’

Comprehend the fundamental rules of a language.

+

Understand Syntax.
Identify different operators of Python.

‘

MORE ON PYTHON

What will be the output if the given statements are typed in interactive Python mode?

1. >>>’Python is Fun’

2. >>>30+ 30

3. >>>’Shubham\Shubhi’

4., >>>100% 30

c\ Note:

¢ . o : .
bR Assist students in doing the above exercise and give some more statements to them.
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Hello Friends! We covered the fundamentals
of the Python programming language in the
previous class. More information about the
rules that govern the Python programming
language will be covered in this chapter.

There are several laws that apply to every human language. These principles are language-
specifici.e., we adhere to the linguistic rules of the language in which we are communicating.
Similar to this, if you want to instruct a machine usinga g %_?
programming language, you must adhere to the syntax, .,'_p

Python is one of the 9 languages that

or set of rules of that language.
influenced the design of JavaScript.

@ SYNTAX

The collection of guidelines that must be followed while writing programming statements is
known as the syntax. The interpreter will highlight a statement mistake if the proper syntax
is not used.

For example, your science teacher finds
out that the labelling of the diagram done
by you is not correct, then she will mark
the labelling as incorrect.

& & Do You Know?

Many big names use Python for their products/services.
Some of these are NASA, Google, IBM, Nokia,etc.

A syntax error might cause the programme to stop working by using improper punctuation,
the wrong keywords, or undefined phrases.

]
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Figure 2.1: Syntex Error
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Look at the program’s output and the interpreter’s error in the example given on the previous
page. The error is highlighted in red.

é VARIABLES

Variables are placed in a computer’s memory where values can be
stored. These values are retrieved from memory during processing,
where they are subsequently processed to produce output. Each
variable has a set of values and distinctive names that make it easier
to find and identify the values that have been stored in memory.

Marks=80

: Marks is a variable that stores the value 80.

PinNo=110032 : PinNo is a variable that stores the value 110032.

é VARIABLE NAMING CONVENTIONS

The guidelines that need to be followed while defining variables are known as variable name
conventions.

An underscore (_) or an alphabet can begin a variable
name.

White spaces are used to create variable names.

A variable name needs to make sense.

Let’s create some programs using variables.

= Let Me Answer

Create two variable names by
following its name conventions.

The names of variables can be made up of letters, numbers and underscores.

Program 1: To print the average of two numbers, write a programme. To store the values,

use the following variables:
numberl, number 2, average , total

A progeem i py = Deflbcees/ 8 denin/Thesktop codn g pangram gy (LE0LT)

File Edi Format Fun Optuom Window Helg
umde £ 1wy

firimle ¥ 2@Eh

ESRAl = OURDer.-nuEEbErd

AvEDAgE =LoTalsd

Prifak["The AVefage ¥ it = .A.'.'F-r.!"'-ll

Figure 2.2: Program1
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@ |DLE Shell 3.10.7

File

2>

2

Edit Shell Debug Options Window

Help

14:08:36)

[M5C w.1933 €4 bit

Python 3.10.7
(AMDE4) ] on win32
Type "help™, "copyright™,

The average of numkers is:

B1.

(tags/v3.10.7:6ccebl3,
"credits"™ or

REESTLART: D:/Users/hdmin/Desktop/coding/programl.py

5

Sep 5 2022,

"license ()" for more information.

Ln:6 Col:D
Output
Program 2: Using variables create a program to convert Kilograms into Grams.

A programl.py - D\Users\Admin\Desktophpythen\program2.py (3.10.7) — O x
File Edit Format Run Options Window Help
kg=958 LS
grams=1000
total =kg*grams
print ("Total Grams=",total)

D - L1 Col:0

Figure 2.3: Program 2
— O pd

" IDLE Shell 3.10.7

Edit Shell Debug Options

File

Window Help

14:08:36)

[M5C +.1933 €4 kit |

Python 3.10.7
LMDE4) ] on win32
Type "help™,
Bl

Total Grams= S5000
il

v

Computer-7

"copyright™,
RESTART: D:‘\Users\LAdmin‘Desktop\pyvthon\programz.py

(tags/v3.10.7:6ccebl3,

Sep 5 2022,

"credits™ or "license ()™ for more information.

Output
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Program 3: Create a program to print the marks scored by Ajeet in the following subjects.

1. Engligh 2.Hindi 3.Math 4. Science

@ program3.py - De\UsershAdmintDesktop\codingprogram3.py (3.10.7) — O X

File Edit Format Run Opticns Window Help

lst'.:_narf.e=’ LijeeL™

Eng=87

Hin=&9

Mat=52

Sci=88

total=Eng+Hin+Mat+5Sci

print (stu_name, "Scrored=",total, "Harks")

Lm:1 Cok
Figure 2.4: Program 3

& |DLE Shell 3.10.7 - O >
File Edit Shell Debug Options Window Help

Python 3.10.7 (tags/v3.10.7:6ccebl3, Sep 5 2022, 14:08:36) [MSC v.1933 64 bit |

AMDE4) ] on winiz

IType "help", "copyright™, "credits™ or "license ()™ for more information.
x>

EESTART: D:‘\Users\Admin\Desktop\coding'program3.py

Ajeet Scrored= 336 Marks

>
Ln:6 Col:0
Output

é INPUT FUNCTION

The input function in Python is used to receive user input. The input function is used to

collect values from users and save them in a variable.
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Create a table in the excel and list the best antivirus available.

- = Kids’ 1Q J

’ Let’s Recall

A computer virus can damage or remove crucial data from your computer.

o Computer viruses along with worms, trojan horses, keyloggers, spyware, adware,
and other malicious software are all examples of malware that can harm your
computer.

o A simple virus poses a threat since it will swiftly exhaust all available memory and
crash the computer system.

e A Trojan horse is a program downloaded and installed on a computer that appears
harmless, but is, in fact, malicious.

o A programme that can duplicate itself, or create copies of itself, is referred to as a

A. Fill in the blanks.

1. A computer ............ can damage or remove crucial data from your computer.

2. All computer viruses are produced by .....................
3. Aslong as the computer is turned on, the ................ is active.
4. A programme that can duplicate itself is referred toas ...................

BV ..ininng in 2021 was a mass-mailing worm.

B. Answer in one word.

1. Software to detect and remove viruses.




4. It usually spreads with email attachments and removable hardware devices.

----------------------------------------------------------------------------------------------------------------------------------------------

C. Answer the following questions.

1. Whatis a computer virus?

----------------------------------------------------------------------------------------------------------------------------------------------

..............................................................................................................................................

..............................................................................................................................................

If your computer is infected by a virus, then what steps would you take? Mention
them in detail.

Pair up with your friend and write the following details.
1.  Which antivirus do you use?
2. Which antivirus does your friend use?

3. Which antivirus does your school’s computer have?
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Guess Who am I?

9030

—

The horizontal area

of a chart.

Set of rules that needs
to be followed for
writing programming

statements.

IE billion
people log
" on to this site
daily.
A cyber-attack that involves

the use of charging pots.

Computer-7
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Play this game with your friends and answer each question one by one.

What is
computer How does CSS
virus? save time?

How do you
organise your
files?

Can you Move ahead Name the
What is live without 3 spaces componenets
the trojan computers? of a cha
horse? X ‘,

What are
Do you . identifiers?
What is know a
yberbullying? lot about
computers?

What
is data

Go back Move 1 science?
to start = : step ahead

What is
the best
thing about
computers?

Explain the
skills required
to become a data

What do Define What are
you mean cyber safety. psychological
by juice models ?

scientist

jacking?
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